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2 Introduction

Introduction

Thousands of dental practices use Dentrix to run their dental practice . Dentrix boosts 
staff productivity, enhances professionalism, helps keep chairs full, increases collections, 
and improves the bottom line . And, with its extensive suite of eServices products and 
third-party partnerships, Dentrix provides many profitable integration solutions .

This Installation Guide will help you install and register your Dentrix G5 software . 

Before Instal l ing Dentrix

Before installing and using Dentrix, you should be familiar with using the computer . The 
Dentrix documentation is written with the assumption that you are familiar with using a 
PC and Microsoft Windows .

Microsoft Windows must be installed before you can install Dentrix . For information on 
supported Windows versions, read the Dentrix G5 System Requirements included in the 
box with your software and available online at www .dentrix .com . For information about 
installing and using Windows, refer to the Windows documentation . 

How To Get Help

Henry Schein recommends that dental offices contact Henry Schein TechCentral 
(1-877-483-0382) or another qualified integration specialist for new installation or 
upgrade assistance .

You can find answers to many questions about Dentrix in the Dentrix G5 User’s 
Guide (available on Windows desktop after installing Dentrix and in the Dentrix 
Resource Center at www .dentrix .com/resource-center), or in the Dentrix Help, which 
you can access from the Help menu of each Dentrix module . You can find additional 
information, including on-demand tutorials, at www .dentrix .com/resource-center .

If you are on a current Dentrix Customer Service Plan, you can access the Dentrix 
technical support knowledgebase at www .dentrix .com/resource-center for answers to 
common questions .

If these methods do not provide an answer, contact Dentrix Customer Support at 
1-800-DENTRIX . Toll-free telephone support is available only to registered Dentrix 
users on a current Dentrix Customer Service Plan . Registered users not on a current 
support plan will be charged for telephone support . (For current pricing information, 
visit www .dentrix .com/support/contact-us .aspx .) 
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Support is limited to the current version of the software and one prior release . When 
calling customer support, be near a computer running the Dentrix software . Be 
prepared to give the following information:

•	 Your name and the name of the practice

•	 The Dentrix customer number assigned to the practice

•	 The version number of the product being used

•	 The type of network being used, if any

•	 The version of Windows installed on the computer

•	 The exact wording of any messages that have appeared on the screen

•	 The circumstances surrounding the question or problem

•	 Steps that have been taken to reach a solution 

Installing Dentrix G5 From a DVD

In an effort to provide you with current technology solutions, the Dentrix G5 
installation program is on one DVD . Most modern computers have DVD readers 
installed . If your computers meet the Dentrix G5 system requirements, installing 
Dentrix G5 from DVD will not be a problem for your office . If you have any questions 
about installing from DVD or want to make sure your hardware is ready for Dentrix 
DVD installation, please contact your hardware technician or call Dentrix Customer 
Support at 1-800-DENTRIX .
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New Features

Some of the new features available in Dentrix G5 are briefly described in this section . 
For additional information about these features and other changes in Dentrix G5, refer 
to “What’s new in Dentrix G5?” in the Dentrix Help, and the Dentrix G5 Release 
Guide in the Documentation folder of the Dentrix G5 DVD and in the Dentrix 
Resource Center .

Ledger

•	 You can now receive and post electronic insurance payment information to the 
Dentrix database using an electronic Explanation of Benefits (eEOB) or Electronic 
Remittance Advice (ERA) . The Batch Insurance Payment Entry dialog box has 
been modified so you can easily enter check insurance payments and review, edit, 
and post electronic insurance payments from the same location . The new Batch 
Insurance Payment Entry dialog box makes it easy to view all outstanding claims 
in the Ledger for a particular family . When you receive electronic EOBs (eEOBs) 
via eServices, Dentrix saves a copy of the EOB to the Document Center and 
automatically attaches it to each each patient and insurance plan on the eEOB .

•	 Dentrix now notifies you when an attachment is missing from an insurance claim . 
Those who use eClaims will be notified when they submit a claim if the payor 
requires a claim attachment for specific procedures and the attachment is missing . 
This will help reduce the number of claims that are rejected .

•	 A new screen capture feature lets you select an area of the screen, capture it, and 
automatically attach the image to an insurance claim and save the image in the 
Document Center .

Office Manager

•	 Monitoring when someone previews or prints Day Sheet and Audit Trail reports 
is easier now . Each type of report has its own record in the Dentrix database 
and its own series of sequential audit numbers so that you can track each report 
type individually . Dentrix stores the last audit number used for each report and 
increments it the next time someone previews or prints a report . The audit number 
prints in the lower left corner of each report . Each time someone previews or prints 
a report the audit trail entry now includes the type of report, the audit number, and 
the date and time stamps of the report . If you have enabled passwords, the audit 
trail also includes the user name . Knowing who previewed or printed what type of 
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report and when can make it easier for you to identify possible instances of fraud in 
your office .

•	 Switching in and out of the Tutor database is much easier than before . After 
you switch out of the Tutor database, Dentrix automatically reconnects to your 
practice’s live database .

•	 For insurance payments made for multiple patients or more than one patient in a 
family, you can list each patient and the amount paid per patient below the check 
that appears on the Deposit Slip Report and the Daily Collections Report .   

Patient Char t

•	 The Patient Chart has an enhanced “Refresh” feature that reloads any changes 
made to setup configurations when you click File > Refresh, such as added/edited 
procedure codes, multi-codes, provider information, medical cross-coding, clinical 
note templates, and so forth .

Miscellaneous 

•	 The Dentalink intra-office communicator lets you receive and send messages 
instantly to other computers in your office . When someone sends you a message, 
a message bubble appears, and you can then reply to the message . Your sent and 
received messages are recorded automatically in a conversation log . Information 
on using Dentalink,  eSync, and other eSync plug-ins is available in the 
Dentrix Help after you install eSync . For more information about eSync, visit 
www .dentrix .com/products/eservices/esync/g5-esync-download .aspx

•	 Dentrix G5 now uses a true client-server database architecture . This architecture 
adds additional stability and efficiency to the software because the server rather 
than the workstations now performs the work of retrieving and writing data to and 
from the database .

•	 The Select Patient dialog box introduced in Dentrix G2 is now the default method 
for selecting patients in all modules for new Dentrix installations .
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Tips for a Successful Installation

For a successful installation, read the following information before installing Dentrix . 
Call 1-800-DENTRIX or send an e-mail message to support@dentrix .com for any 
questions related to these installation tips .

1 Meet the System Requirements: Make sure the server and workstations on your 
network meet the current system requirements before you upgrade to or install 
Dentrix G5 . The current Dentrix G5 System Requirements are included in the box 
with your Dentrix software and are available online at www .dentrix .com . 

2 Back Up Your Data: Create a backup of the server’s hard drive . If you are 
upgrading, back up the server’s Dentrix directory and all subdirectories . If any 
Dentrix data is stored elsewhere on the system, back up that directory as well . 
Verify the integrity of all backups to be sure you have a good backup before 
upgrading from a previous version of Dentrix . For more information, refer to 
the eBackUp 12 .0 for Dentrix G4 Recommendations document in the Dentrix 
Resource Center at www .dentrix .com/resource-center .

3 Check Available Disk Space: From the Start menu, select My Computer . Right-
click the C:\ drive icon and select Properties . The Local Disk Properties dialog 
box appears, and the General tab displays the used and free disk space . Refer to the 
Dentrix G5 System Requirements for the required free hard disk space for servers 
and workstations . The current Dentrix G5 System Requirements are included in 
the box with your Dentrix software and are available online at www .dentrix .com .

Note: If you use imaging software and/or the Document Center, you must dedicate an 
additional 30-40 GB of hard drive space in addition to what is needed for the G5 Server 
installation .

4 Prepare for Server and Workstation Installation: Find the Serial Number/Activation 
Code card inside the Dentrix G5 software box . These numbers will be needed 
during the installation . You can find these numbers in the box with your Dentrix 
software . If you are upgrading, check the Batch Processor for reports . Print the 
reports and clear the Batch Processor . Send all unsent electronic claims . 

Note: The Dentrix G5 installation/upgrade process could clear any reports in the Batch 
Processor and delete any unsent electronic claims .
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5 For Upgrades, Verify the Correct Version is Currently Installed: Dentrix G4 or higher 
must be installed before you can upgrade the program to Dentrix G5 . To determine 
which version of Dentrix is installed, in the Office Manager, from the Help menu, 
click About Office Manager . If the version is older than Dentrix G4, all product 
upgrades must be installed to bring the version to Dentrix G4 . For example, if Dentrix 
11 .0 is currently installed, you must upgrade to version G4 before installing 
Dentrix G5 . 

6 Exit Dentrix at Each Workstation and Close Other Programs:Before installing 
Dentrix, close any Dentrix modules and any other programs on the Dentrix server 
and all workstations . To avoid conflicts and allow access to all files and directories, 
you should disable any anti-virus and screensaver software and then re-enable it 
after you have completed the Dentrix G5 installation . During server installation, 
it is best to shut down each workstation (to prevent others from starting Dentrix 
while it is being updated) .

7 Verify the Dentrix G5 DVD Configuration: Verify that the Dentrix G5 Installation 
DVD is the right DVD for your office configuration . The available DVD versions 
are SINGLE USER, MULTI USER, MULTI USER OFFICE, and SINGLE 
USER OFFICE .

8 Follow the Installation Instructions: Make sure you follow all of the step-by-step 
instructions in the Dentrix G5 Installation Guide as you install Dentrix G5 .

9 Finish the Installation Completely: Do not interrupt the installation process, even 
if it appears as though nothing is happening . You will be prompted when the 
installation is ready to continue . Terminating an installation prior to completion 
could affect the integrity of the database . Terminate the installation only if you are 
directed to do so by Dentrix Customer Support .

10 Before installing Dentrix G5: Be sure to check with the applicable application 
vendors to access these G5-compatible versions . To see a list of authorized 
vendors with applications designed to integrate with Dentrix G5, visit: 
www .Dentrix .com/integrated .
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Installing Dentrix G5

Read the Tips for a Successful Installation before beginning the installation . If Dentrix 
is being installed on a networked system, the installation process must be completed 
on each workstation . Install Dentrix on the file server (the computer where the practice 
database will be stored) first . 

1. Insert the Dentrix G5 DVD into the DVD drive . If the DVD drive is equipped 
with AutoStart technology, the Dentrix G5 installation Welcome screen will appear 
within a few seconds . 

If the Dentrix G5 installation Welcome screen does not appear:

A. Click the Windows Start button and then click Run . 

B. The Run dialog box appears .

C. In the Open field, type D:\DENTRIX_G5 (where D: is the drive letter for the 
DVD drive) . 

D. Click OK to begin the installation . 
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2. Click INSTALL NOW to begin the installation .  

Dentrix performs a check of your system to verify that all required components 
(such as the required versions of Microsoft  .NET Framework) are installed on your 
computer . After Dentrix has performed the check, Dentrix prompts you to install any 
required components that are not already installed . 

Note: If the Microsoft  .NET Framework 3 .5 .1 and 4 .0 are not already installed on your 
computer, installing them will require several minutes . After they are installed, your computer 
will need to be rebooted .

A. Click INSTALL NOW . 

B. When it is finished, click Finish .  

3. At the Dentrix G5 screen, click INSTALL NOW .

Dentrix installs several prerequisites, such as the Edidev runtime and Crystal 
Reports prerequisites, which are needed for Dentrix G5 . This will probably take 
several minutes .
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The Dentrix installation then displays the Welcome screen . 

4. After you have read the Tips for a successful installation, select I have read and 
followed the tips for a successful installation and click Next to continue . 

Note: If you are upgrading from a previous version of Dentrix, you will be prompted again to 
back up your data before proceeding . If you have backed up your data, click Yes to continue 
with the installation .
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The End User License Agreement screen appears .

5. After you have read the Software End User License Agreement, select I accept the 
terms of the license agreement and click Next to continue . 

The Select Installation Type screen appears . 
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6. Select the type of installation you are performing: 

•	 Server - Select this type of installation if you are installing on the computer that will 
act as the Dentrix server for all other computers on the network . 

•	 Workstation Install Only - Select this type of installation if you are installing 
Dentrix G5 on a front office or clinical workstation over a network and have 
already run the server installation on another computer on the network .

7. Click Next .

If you selected the Server option, and the Dentrix installation detects other Dentrix 
database servers on your network, you will be prompted to either configure this 
computer as a workstation (recommended) or continue and configure this computer as 
a duplicate server .

If you selected the Workstation Install Only option, you will be shown a list of 
available Dentrix servers and prompted to select the server you want to connect to .

Select the server you want to connect to and click OK .

Dentrix runs a system requirements check . If your system meets the requirements, 
the installation continues to the next step . If it does not meet the requirements, the 
Dentrix System Requirements Notice dialog box displays what your system needs in 
order to meet the system requirements . 
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8. If the System Requirements Notice dialog box appears, verify the system 

requirements . A green check mark indicates that a component meets the 
requirements . A red “X” indicates that a component does not meet the 
requirements . To discontinue the installation and install the required components 
(recommended), click No to stop the installation . Click Yes to continue the 
installation without the recommended system requirements . 

The User Name and Serial Number screen appears .
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9. Enter your User Name and Serial Number . Your serial number is on the Serial 
Number/Activation Code card inside the Dentrix G5 software box . 

If you are upgrading, the serial number you previously used to install Dentrix will 
automatically appear in the Serial Number field . It is very important to verify that the 
serial number in the field is the serial number that was assigned to your office when 
you originally purchased Dentrix . In some instances, the serial number shown may not 
be the one assigned to your office . 

To verify that your serial number is correct, consult the card that was included in the 
box with your Dentrix software . Enter the serial number that was assigned to your 
office to continue with the installation . 

IMPORTANT! You must enter the serial number that was assigned to your office in the Serial 
Number field in order for the registration/activation and Check for Updates features to 
function properly .

10. Click Next . 

The Select Installation Type screen appears . 

11. You can perform one of two installation types: Typical or Advanced . With a 
typical installation type (recommended for most computers), folders are placed in 
the default locations, and all of the default Dentrix G5 features are installed . With 
the advanced installation, you can specify the location of the Dentrix files . 
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If you select Typical, the Start Installation Screen appears . Proceed to step 12 . If you 
select Advanced, the Dentrix Server Drive Select dialog box appears . Follow these 
substeps before proceeding to step 12 . 

A. Select the drive where you want to install the Dentrix server files and click Select .

The Choose Destination Location screen appears .

B. To change the folder locations, click Browse, navigate to the desired location, 
and then click Next . If you want to use the default folder locations, click Next .  
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The Start Installation Screen Appears .

12. Review the settings that have been specified for your installation . If you want 
to make changes to any of the settings, click Back and change them . When the 
settings are correct, click Install to begin installing Dentrix G5 . 

If you are performing a server installation, the CDT 2011-2012 Procedure Code 
Update dialog box appears .

13. Click Update if you want to update your CDT Procedure Codes, or click Skip . 

If you chose Update, when the update is finished, click Continue .
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A message box will ask if you want to convert an existing Dentrix database or install a 
blank (empty) database (for new users) .

14. Click Yes if you want to convert an existing database, or No if you want to install a 
blank database .

If you are upgrading to Dentrix G5 and converting your Dentrix database, a message 
appears, stating that the Dentrix G5 conversion can require considerable time 
depending on the size of your database . If you want to proceed with the database 
conversion and Dentrix installation, click Yes .

As Dentrix is being installed on your computer, the Setup Status screen displays the 
current setup status .

Note: If you see the Microsoft Office Customization Installer message at some point, click 
Install to continue the installation of this component .
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If you have installed eSync 3 .0 or later on the computer, the Dentrix installation will 
install the latest version of eSync and the eSync plug-ins, which includes Dentalink, an 
intra-office messaging tool .

If eSync 3 .0 or later is not installed on the computer, you will 
need to download and install the latest version of eSync at 
www .dentrix .com/products/eservices/esync/g5-esync-download .aspx .

After Dentrix is installed, the Setup Complete screen appears .

 
15. Click Finish .
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A Backup Warning message appears, letting you know that Dentrix G5 uses a new 
location for its database .

16. Click OK .

The Dentrix Server Administration Utility appears . Use this utility to schedule 
recurring exports of your Dentrix database to be backed up using your backup software 
(sold separately) .

If you need assistance using the Dentrix Server Administration Utility to schedule 
database exports, please contact Dentrix Customer Support at 1-800-DENTRIX .

17. When finished, click Exit .
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Note to integrators: For network installations, the C:\DENTRIX\ Common folder on 
the server should be shared . (The Dentrix installation will attempt to automate this .) 
The Dentrix installation will add these exceptions to the Windows firewall (any third-party 
firewalls should be configured so that these ports are open): TCP 6602, TCP 6603, TCP 
6604, TCP 6605, TCP 6606, UDP 6600, TCP 6597, and TCP 5712 . 

Registering/Activating Dentrix G5

You must register and activate Dentrix G5 in order to run your software and receive 
update information . It is recommended that you register and activate Dentrix at the 
time of installation . If you do not register at the time of installation, the activation 
dialog box appears when you open any Dentrix module . You have 30 days in which to 
register before registration/activation is required to use your software .

You can register/activate your software by clicking Register Now . You can temporarily 
skip the registration/activation process by clicking Register Later . 



21Registering/Activating Dentrix G5

Register Now

You only need to register your software once, regardless of how many workstations 
you have . 

To register your software

1. From any workstation, click Register Now on the registration/activation dialog box . 

The serial number and activation code verification dialog box appears . 

2. The serial number you entered when you installed Dentrix G5 appears in the Serial 
Number field . Verify that the serial number matches the serial number assigned to 
your office . You can find your serial number on the Serial Number & Activation 
Code card inside the Dentrix G5 software box .

3. In the Activation Code field, enter the activation code assigned to your practice . 
You can find your activation code on the Serial Number & Activation Code card 
inside the Dentrix G5 software box .

IMPORTANT: You must enter the correct serial number and activation code assigned to your 
practice . If you do not enter the correct serial number and activation code, you will not be 
able to activate the software properly or download the correct updates for your software .  
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4. Once you have entered the correct serial number and activation code, click Next . 

5. Select the desired option: Register Online, or Manually enter registration code . 

Note: Registering online requires a valid Internet connection . If you do not have an Internet 
connection, you must manually enter the registration code . 

These options are explained below .

Registering Online 

To register your Dentrix software online

1. Click Register . 

The registration utility checks your serial number and automatically registers and 
activates your software . A message appears when the activation has been completed 
successfully .

2. Click OK . 
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Manually Entering Registration Code

To register your Dentrix software manually

1. Call Dentrix Customer Support at 1-800-DENTRIX to obtain your complete 
registration code . When you call, you must have your full serial number available, 
which is located on the Serial Number & Activation Code card inside the Dentrix 
G5 software box . 

2. Dentrix Customer Support will provide you with a 16-digit registration code . Enter 
your registration code (obtained by calling Dentrix Customer Support) in the fields 
provided (four digits in each field) . 

Important: The activation code found on your Serial Number & Activation Code Card is for 
online registrations only, and is not the registration code you should enter here .

3. Click Register . 

A message appears when the activation has been completed successfully .

4. Click OK .   

Register Later

If you click Register Later on the registration/activation dialog box, the reminder will 
continue to appear once a day when you open Dentrix until the end of your 30-day 
grace period . After 30 days, the Register Later button is disabled on the registration/
activation dialog box, and you must register Dentrix G5 before you can use it . Follow 
the steps in the Register Now section above to register/activate your software so you 
can use it .
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Smart Upgrades

You can use the Smart Upgrades feature to deploy Dentrix G5 to the other computers 
on your network without accessing the setup files on the server or taking the DVD to 
the other computers .

As with all versions of Dentrix, once you have installed updates on any computer on 
your network, Dentrix requires you to install the updates on all other computers on 
your network .

With Dentrix G5, this process is automated . When you attempt to open a Dentrix 
module on a computer that has not yet installed the required updates, a message box 
appears, notifying you that the computer needs to install updates .

You must install the required updates to use Dentrix on that computer . If there are 
optional updates to install, you can choose to install those updates, but it is not 
required to run Dentrix . 

To install the updates, click Install . All open Dentrix programs close, and an install 
status message box appears . The updates install, and you can then access Dentrix on 
that computer .

Note: If you stop the installation before it is finished, you will be prompted to install the 
updates again when you try to access Dentrix .
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Installing Dentrix G5 Over a Network

If you do not want to use the Smart Upgrades feature to install Dentrix G5 on the 
other computers on the network, you can follow these instructions and install 
Dentrix G5 from the setup files on the server . This installation method does not 
require the DVD . 

To install Dentrix G5 over a network

1. Click the Windows Start button and click Run .

2. Enter \\[server]\Common\Installs\G5\Setup.exe on the command line, where 
“Server” represents the name of your server on the network . The Installation Setup 
screen appears for several seconds, followed by the Welcome screen .

3. Click Install Software . The screen that appears lists the products you can install . 
From this screen, you can install Dentrix G5 and the Required Components .

4. Click Install Dentrix G5 .  
The InstallShield Wizard displays the Welcome screen . 

5. After reading the Tips for a Successful Installation, select I have read and 
followed the tips for a successful installation and click Next to continue .

6. Read the Henry Schein Software End User License Agreement . When you have 
read the document, select  
I accept the terms of the license agreement and click Next to continue . 

Note: You can print a copy of the Henry Schein Software End User License Agreement 
by clicking the Print button .

7. Select the type of installation you are running from the list . 

8. When you click Next, Dentrix will run a System Requirements check . If your 
system meets the requirements, the installation continues to the next step . If your 
system does not meet the requirements, the Dentrix System Requirements Notice 
dialog box displays what your system needs in order to meet the system requirements .

9. Enter your User Name and Serial Number that was included in the installation 
package . If you are upgrading, the serial number will automatically appear in the Serial 
Number field . A valid serial number must be entered for the installation to continue . 
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10. You can perform one of two installation types: Typical or Advanced . With a 
typical installation type (recommended for most computers) folders are placed in 
the default locations, and all of the default Dentrix G5 features are installed . With 
the advanced installation, you can specify the location of the Dentrix files . 

11. After you have reviewed the installation settings, if you want to make changes, 
click Back and change the settings . When the settings are correct, click Install to 
begin installing Dentrix G5 . 

12. After the Dentrix software has been installed, the Setup Complete screen appears .

13. Select whether you want to restart your computer now or later and click Finish .
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